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Introducao

O presente documento, Explorar o SPSS em Contexto Educativo tem como
finalidade desmontar e reconstruir uma base de dados estatistica aplicavel
em contexto de ensinar e aprender da vsala de aula ao ciberespaco”.
Integra-se num trabalho de formacdo na area da Comunicacdo Educacional

Multimédia e das Ciéncias Sociais € Humanas.

Este documento parte de um estudo de caso. Procura identificar alguns
indicadores de descricdo-explicitagdo de contextos de utilizagdo do
programa, da identificagdo de alguns obstaculos e das estratégias de
remediagdo. Pretende-se integrar uma aprendizagem contextualizada na

pratica profissional dos aprendentes da Sociedade do Conhecimento.

Este trabalho situa-se numa linha de construcdo de um documento
hibrido, ou seja, apresenta, por um lado, uma estrutura de
desenvolvimento escrita que tenta explicitar os procedimentos a realizar
para se conseguir trabalhar com o programa e, por outro lado, apresenta
um suporte digital materializado no site da ESES!?, onde estdo publicados os

dados obtidos numa experiéncia especifica.

Assim, na parte escrita, propbe-se um breve historial do programa; em
segundo lugar, procura-se fazer um levantamento de literatura sobre a
construcdo de questionarios adaptéveis ao programa em estudo e, por
ultimo, apresenta-se uma descricio do processo de insercdao de

variaveis conducente & obtencdo de dados para analise.

! para ter acesso aos ficheiros utilizados neste documento pode consultar ©

http:{,!www.eses.pt{bases_dadosfpubiica.asp




Historial

O programa foi criado nos anos 60 pela empresa Norte Americana SPSS
Inc.. Mais tarde, em Dezembro de 1994 foi implementado em Portugal pela
empresa PSE - Produtos e Servigos de Estatistica, Lda. Trata-se de um
Software de analise estatistica (2) constituido por um sistema de base e por
oito médulos de escolha opcional consoante o tipo de pesquisa - SPSS
Profissional Stat.; SPSS Advanced Stat.; SPSS Tables; SPSS Trends; SPSS
categories; SPSS Conjoint; SPSS Exact Tests; SPSS Missing Values.

O sistema de base com que trabalhdmos (SPSS Base System), inclui todas
as ferramentas necessarias a introdugdo de dados e, numa segunda fase &
representagao grafica dos mesmos. SPSS apresenta-se como uma aplicagao
de facil manuseamento visto que a sua apresentacdao e o modo como

funciona sdo semelhantes a qualquer aplicacdo desenvolvida para Windows.

A vantagem deste programa em relagdo ao EXCEL reside nos seguintes
factos:

- permite aplicar varias andlises estatisticas como por exemplo, a anélise de
regressao, testes paramétricos e ndo paramétricos; permite estabelecer a
correlacdo entre variaveis.

- permite a visualizagdo de varios resultados estatisticos em forma de

tabela e grafico.

* Segundo o Dicionario da Lingua Portuguesa Contemporinea da Academia de Ciéncias de Lisboa,
estatistica é "o estudo metédico que tem por objecto a observacdo de um certo nimero de factos
sociais, de uma realidade..e a respectiva ordenacdo, andlise e interpretagdo de dados numéricos
obtidos. Estatistica descritiva é a pesquisa que retine dados numéricos, calcula médias e indices.”
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Parte I - Pesquisar

Introducgao

Por que razdo podem os estudantes de areas proximas das Ciéncias Sociais

aprender a analisar dados quantitativos?

Porque uma grande parte da pesquisa empirica desenvolvida no ambito das
Ciéncias Sociais é planeada para produzir dados quantitativos ou, ent3o,

apoia-se neles.

Porque ser capaz de avaliar a qualidade de estudos e as suas analises
estatisticas se revela de grande utilidade, mesmo na vida quotidiana. De
facto, somos confrontados constantemente com dados estatisticos, seja na
forma de estudos de opinido, estudos de mercado, inventarios de atitudes,
sondagens politicas, estatisticas oficiais, etc. O dominio da analise dos
dados quantitativos aumenta a nossa capacidade para reconhecermos

conclusdes deficientes ou manipulagdo da informagao.

Porque os dados estatisticos podem ser distorcidos. Para poderem estar
seguros da qualidade dos seus proprios dados e do tipo de analise a
utilizar, os estudantes tém vantagem em conhecer os métodos e as
técnicas de recolha de informacdo, assim como os métodos de analise

adequados.

Porque a construgdo de instrumentos de recolha de dados e a analise de
dados quantitativos ndo sdo tarefas simples. No entanto muitos dos
aspectos técnicos relacionados com 0 processo de investigacdo em Ciéncias
Sociais foram ja sistematizados por diversos autores entre os quais se
podem destacar BRYMAN e CRAMER (1993), CARMO e FERREIRA (1998),
FODDY (1996), GHIGLIONE e MATALON (1993) e LEVIN e FOX (2004).

11



Que técnicas utiliza o investigador social para recolher informacao?

O investigador social realiza frequentemente investigacdes para aumentar o
seu grau de compreensao sobre 0S problemas e as questdes que se€
colocam no seu campo. A investigacdo social pode assumir muitas formas €
ser utilizada para pesquisar uma ampla gama de assuntos. Entre as
técnicas mais utilizadas pelo investigador para testar as suas hipoteses e
responder as suas questbes, encontram-sé 0 inquérito por questionario, a

entrevista, a observagao e a analise de conteudo.

Que é um inquérito?

Pode definir-se inquérito como O processo atraves do qual se tenta
descobrir alguma coisa de forma sistematica. Em Ciéncias Sociais, o termo
inquérito é usado para designar processos de recolha sistematizada de

dados que poderdo ser comparados.

Se inquérito designa 0 processo global de recolha sistematica de dados,
inquérito por questionario designa o processo de recolha de dados cuja

analise posterior se pretende quantitativa e estatistica.

Por que razdo utiliza o investigador social a estatistica?

O investigador social procura descrever, explicar e predizer O
comportamento humano. Nesse processo, examina caracteristicas do
comportamento humano chamadas varidveis - caracteristicas que definem
ou variam de um individuo para outro (por exemplo, idade, classe social,
escolaridade, profissao, comportamento ou opinido face a uma determinada
questdo, etc.), ou que variam no decorrer do tempo (por exemplo,

desemprego, taxa de natalidade, etc.).

Unidade de analise

Além de especificar variaveis, 0 investigador social pode determinar
também, a unidade de anélise ou unidade de observacdo para a pesquisa.

De um modo geral, 0S investigadores recolhem dados sobre pessoas. Nesse
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, o individuo é a unidade de analise a ser observada pelo investigador.
entanto, o investigador pode interessar-se por agregados ou seja
dar, como variam certos aspectos em conjuntos de pessoas (familias,

presas, unidades residenciais, etc.).

‘Teoria e hipoteses

O ponto de partida neste tipo de processo de investigacdo € o
- enquadramento teérico. A partir do momento em que uma teoria -
formulada, é provavel que o investigador a queira testar de modo a
verificar se ela continua a revelar-se adequada perante as evidéncias
empiricas. No entanto, raramente é possivel testar uma teoria no seu todo.
0 mais frequente é deduzir-se, a partir da teoria, uma hipétese que se
relacione com um aspecto limitado daquela, que sera submetido ao teste

da verificagao.

As hipdteses estdo relacionadas com as ideias que 0 investigador social tem
da realidade social. Essas hipdteses expressam-se frequentemente por uma
afirmacdo sobre a relagdo existente entre, no minimo, duas varidveis: uma
varidvel independente que influencia (causa presumida) e uma variavel
dependente (efeito da variavel independente). Por exemplo, o investigador
pode formular a hipétese de que as raparigas utilizam menos o correio
electrénico do que os rapazes. Para confirmar tal hipétese pode fazer um
estudo onde ira relacionar o sexo (varidvel independente) com a utilizagao

do correio electrénico (variavel dependente).

Muitas vezes, as hipoteses apresentam-se como uma relagdo entre
conceitos, ou seja, categorias onde se “arrumam” as ideias e observagdes
sobre a realidade em geral. As hipéteses tém a vantagem de forcar o

investigador a pensar de forma sistematica e a estruturar o seu plano de

investigagdo.
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As etapas da investigacdo em ciéncias sociais

Testar ideias sobre a natureza da realidade social exige uma investigagao
cuidadosamente planeada e executada na qual se verificam, regra geral, as

seguintes etapas:

1. Reducdo do problema a ser estudado a uma hipdtese passivel de
teste (por exemplo, os rapazes utilizam mais a Internet do que as
raparigas);

2. Elaboracdo de um conjunto apropriado de instrumentos (por
exemplo, um inguérito por questionario, uma entrevista ou uma
grelha de observagao);

3. Recolha dos dados (trabalho de campo);

Analise dos dados para avaliar a sua influéncia sobre a hipotese
inicial (se se tratar de uma analise quantitativa, o investigador pode

recorrer a softwares especificos como 0 SPSS);

.

Interpretagao dos resultados da andlise, e revelacdo dos mesmos

(por exemplo, através de um relatdrio ou comunicacdo publica).

Operacionalizagdo de conceitos

Para se avaliar a validade de uma hipbtese é necessario desenvolver
formas de medir os conceitos a qIL.IE! ela se refere. A este processo chama-
se, geralmente, operacionalizagédo - tradugdo dos conceitos em variaveis,
isto é, em atributos que estabelecam diferengas entre unidades de analise

relevantes (pessoas, grupos, empresas, etc.)

Seleccdo de inquiridos ou de sujeitos

Para levar a cabo um estudo, O investigador social necessita de encontrar
as pessoas certas para aplicar o instrumento de medida que concebeu (por
exemplo, num estudo quantitativo, um inquérito por questionario de auto-
aplicagdo). Como raramente é possivel ou viavel contactar todos 0sS
elementos de uma populagdo, torna-se necessario seleccionar uma
amostra. Para existir a possibilidade de generalizagdo a uma populagao

mais ampla, a amostra tem que ser uma amostra representativa, o que
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ser garantido seguindo uma série de procedimentos técnicos

cos das teorias da amostragem.

portancia da medida na analise de dados: Utilizacdo de séries
méricas na investigacao social

igador social tenta avaliar e medir diferentes tipos de fenomenos,
r exemplo: atitudes politicas, niveis de satisfacdo, indices de consumo,
"s culturais, etc. A maioria dos investigadores esta de acordo quanto
mportancia da medida na andlise dos dados. Ao medir uma determinada
racteristica, é lhe associada uma série de numeros de acordo com um
: unto de regras. (Ex: Numa escala de 1 a 5, onde 1 representa
scordancia total e 5 Concordéncia total, em que medida concorda ou

scorda com...?).

; nimeros desempenham pelo menos trés fungdes importantes para o0s
_"- igadores, dependendo do tipo de medida particular utilizado.

pecificando, as séries numericas podem ser usadas para:

1 - Classificar ou categorizar no nivel nominal de medida;
2 - Ordenar por posicdes no nivel ordinal de medida;

3 - Atribuir um escaldo no nivel intervalar de medida.

:scalas ou niveis de medida

a conhecer e avaliar as caracteristicas de uma populagdo é necessario
dentificar varidveis pré-determinadas e medi-las. Essa medigdo é feita
avés da utilizagdo de escalas ou niveis de medida que, de acordo com a

reza de cada variavel, pode ser de tipo nominal, ordinal ou intervalar.

escala ou nivel nominal de medida consiste em nomear ou rotular.
=ntificam-se os casos de acordo com categorias estabelecidas e contam-
as frequéncias de ocorréncia. Por exemplo, pode caracterizar-se um
po de pessoas através da pertenca as categorias “masculino” ou
=minino” ou as categorias “fumador" ou “ndo fumador”. Ao lidar com
‘dados nominais cada caso pode ser enquadrado em uma e apenas uma
categoria. Ou seja, as categorias podem ser exaustivas e sao mutuamente

exclusivas.
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Quando pretendermos ir para além do nivel nominal e passar para um nivel
onde se ordenam os casos em termos do grau com uma determinada
caracteristica, estamos perante uma escala ordinal de medida. Por
exemplo, em vez de categorizarmos pessoas de acordo com a pertenca as
categorias “fumador” ou “ndo fumador”, poderiamos categoriza-las de
acordo com o grau de toleréncia perante a permissao de se fumar em locais
plblicos fechados. O nivel ordinal de medida fornece informagao sobre a
ordenacdo de categorias, mas né&o indica a magnitude de diferengas entre
nGmeros. Se utilizarmos uma medida de nivel ordinal para estudar o grau
de tolerancia face ao tabagismo n3o poderemos comparar os niveis de
tolerancia entre inquiridos. A posigdo de cada inquirido € subjectiva e pode
ser avaliada e interpretada enquanto tal. Por exemplo, duas pessoas que
igualmente se manifestam como “totalmente contra” a permissao de fumar
em locais publicos fechados podem ter comportamentos muito distintos
face a questdo, no seu quotidiano. As escalas ordinais sao geralmente

utilizadas para medir percepgoes, opinides, atitudes ou preferéncias.

A escala intervalar de medida ndo ordena apenas as categorias mas indica,
também, a distancia exacta entre elas. As medidas intervalares utilizam
unidades constantes de medida (por exemplo, metros, graus Celsius,
quilogramas, unidades de tempo como minutos, dias, anos, etc.), que
fornecem intervalos iguais entre pontos na escala. Algumas varidveis sao
intervalares na sua forma natural (por exemplo, idade, peso, numero de
irm&os, numero de horas que passa ligado & Internet durante uma semana,

etc.).

Os diferentes niveis de medida podem ser utilizados em simultaneo para
recolher informacdo de diferente tipo sobre um mesmo assunto. Por
exemplo, podemos perguntar pela variavel “cor do cabelo” através de uma
escala nominal (louro, ruivo, negro, branco, etc.); podemos perguntar pelo
“tipo de corte” utilizando uma escala ordinal (curto, médio, comprido); e
podemos perguntar pelo “comprimento do cabelo” utilizando uma escala

intervalar (centimetros).
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Escalas comparativas

Existem, ainda, escalas comparativas que permitem a comparacao directa
entre sugestdes. Por exemplo, temos a comparacdo binaria, em que se
apresentam ao inquirido duas opcdes (ordinais) entre as quais tera de
escolher uma, mediante determinado critério. Por exemplo, “gosta mais de
A ou de B?”. Dentro deste tipo de escala encontram-se ainda escalas de
ordenacdo, onde se apresentam simultaneamente diversas opcdes que O

inquirido devera ordenar de acordo com um critério pré - definido.

Escalas nao comparativas

As escalas ndo comparativas sdo técnicas em que cada opcéo de resposta €
avaliada independentemente das outras. Por exemplo, pode perguntar-se
ao inquirido se gosta muito, pouco ou nada de teatro. Exemplo deste tipo
de escalas, a escala de Likert.? Neste tipo de escalas existem tipicamente
cinco categorias de resposta variando entre o “discordo totalmente” e o
“concordo totalmente”. O inquirido pode indicar o seu grau de concordancia
ou discordancia face as afirmagdes apresentadas. As categorias sdo

classificadas de 1 a 5oude -2 a +2.

Note-se que a escala de Likert é uma escala equilibrada, na medida em que
tem um nuUmero impar de categorias e um ponto neutro ou central. A
presenca desse ponto (neutro ou central) pode ter uma influéncia
significativa nas respostas. Se a resposta neutra faz parte das respostas
possiveis e é desejada pelo investigador, utiliza-se uma escala impar. No
entanto, se o investigador pretende levar o inquirido a tomar uma posicao
mais definida, pode utilizar uma escala com um nimero par de categorias
de resposta. Quando se prevé que muitos inquiridos ndo tenham opinido
sobre a questdo colocada, pode evitar-se que muitos respondam
seleccionando o valor central ou neutro (o que iria distorcer o resultado

final), propondo a categoria ndo sabe/ndo responde.

3 para saber mais sobre a construgdo de escalas consulte, por exemplo, Ghiglione e Matalon (1993).
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Por que razdo quantifica o investigador os seus dados? - As fungdes
da estatistica

O investigador social quantifica os seus dados nos niveis nominal, ordinal e
intervalar de medida porque, regra geral, os pretende tratar
estatisticamente. A estatistica surge aqui como instrumento que ajuda a

descrever e a interpretar a realidade.

Descrever a realidade com o auxilio da estatistica

Para chegar a conclusGes ou obter resultados, o investigador social estuda
grandes numeros de pessoas ou grupos. Com a ajuda de dispositivos
estatisticos como a distribuicdo de frequéncias agrupadas, graficos e
médias aritméticas, podem-se detectar e descrever padries ou tendéncias
em distribuicdbes de resultados que, de outro modo, passariam
despercebidos. Neste contexto, a estatistica pode ser definida como um
conjunto de técnicas para a reducdo (ou resumo) de dados quantitativos
(isto €, uma série de numeros), a um pequeno numero de termos

descritivos mais convenientes e facilmente transmissiveis.

Tomada de decisdao - Interpretar a realidade com o auxilio da
estatistica

Para testar hipoteses ndo basta descrever a realidade. Muitas vezes, é
necessario fazer inferéncias de amostras para populagdes. O investigador
social testa as suas hipoteses sobre amostras extraidas da populagdo ou
universos que pretende estudar. E o tipo de amostra e a sua qualidade que
determinam se os resultados poderdo vir a ser generalizados a um grupo
maior de pessoas (populacdo ou universo). O “erro amostral” é sempre
inevitdvel, mesmo quando a amostra é concebida e executada
adequadamente, dai, o problema de generalizar ou fazer inferéncias da
amostra para a populagdo. Existem, porém, técnicas estatisticas que
ajudam o investigador a fazer inferéncias de amostras para populacdes e,

assim, testar hipoteses sobre a natureza da realidade social.
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A preparacgdo de um Plano de Investigagdo

O investigador social utiliza basicamente dois tipos de planos de

investigacdo: planos experimentais e planos correlacionais.

Num plano de investigagao experimental, o investigador manipula aspectos
_da situacdo e observa os efeitos dessa manipulagdo nos sujeitos
experimentais. Este tipo de estudo exige a existéncia de um “grupo
controlo” que serve como base de comparagdo com o grupo submetido a

" manipulagdo experimental.

Num plano correlacional ou inquérito, o investigador ndo manipula qualquer
varidvel e todos os dados relacionados com todas as variaveis sao
recolhidos simultaneamente. O termo correlagéo refere-se, também, a uma

técnica para analisar relages entre variaveis.

Nem sempre o investigador pode escolher qual dos dois tipos de estudos
vai realizar. No entanto, na maior parte dos casos, a natureza do plano de
investigacdo - experimental ou correlacional - define-se logo no inicio do
processo de investigacgao, influenciando todas as fases desse e tendo
implicagbes no tipo de tratamento estatistico que serd executado com 0s

dados dele resultantes.

A recolha dos dados
Nesta fase, o investigador recolhe dados através das técnicas que elegeu,

utilizando os instrumentos de recolha de dados concebidos para o efeito.

Para aprofundar o conhecimento sobre 0s aspectos técnicos relacionados
com o processo de recolha de dados, poderdo ser consultados livros sobre

métodos de investigacdo socioldgica e psicologica.
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Analise dos dados

A recolha dos dados é apenas o comeco no que diz respeito a analise
estatistica. Ela fornece material bruto. O investigador utiliza esses dados,
analisa-os de modo a obter resultados e a testar as suas hipoteses sobre a
natureza da realidade social, podendo, depois, tomar decisdes baseadas

nesses resultados.

Distribuicdo de frequéncias

Depois de recolhidos os dados, o investigador transforma a informacao em
estado bruto resumindo-a e tornando-a de facil compreensao. Para reduzir
grandes quantidades de dados, torna-se possivel detectar padrdes e
tendéncias que, de outra forma, passariam despercebidos. Para tal, o
primeiro passo, consiste em construir uma distribuigdo de frequéncias em
forma de tabela, ou seja, contar os casos registados para cada varidvel. E
provavel que o investigador queira descrever os casos com que trabalhou
pelo menos em termos das varidveis inerentes ao estudo. Para resumir
cada uma das suas varidveis, (chamada, por vezes, andlise univariada),
podera recorrer a varios procedimentos. Por exemplo, para além de avaliar
a distribuicdo de frequéncias de uma variavel, poderad estabelecer a sua
tendéncia central - o valor tipico da distribuicdo, ou seja, a posicdao onde
tendem a concentrar-se os valores da distribuicdo. O investigador podera,
também procurar conhecer a quantidade de variacdo que a distribuicdo
evidéncia (ou seja, medir a dispersdo). Para aprofundar o conhecimento
sobre esta questdo, aconselha-se a leitura de um manual de estatistica ou

de analise estatistica de dados.
Comparacdo entre distribuicées de frequéncias
Para esclarecer resultados e acrescentar informagdo, o investigador

procede a comparacgdo entre distribuigbes de frequéncia.

Por exemplo, para saber se os rapazes utilizam mais a Internet do que as
raparigas, € necessario inquirir toda a amostra sobre as praticas de
utilizacdo desse dominio e em seguida comparar as respostas do grupo das

raparigas com as repostas do grupo dos rapazes.
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- andlise de uma so6 variavel raramente é suficiente para
=<tes da investigacdo. O investigador tera provavelmente v
=resse em conhecer essa ligagdo entre diferentes variaveis, ou seja, em

=r andlise bivariada (quando procura conexoes entre duas variaveis) ou

tivariada (quando procura conexdes entre mais de duas variaveis).
os testes estatisticos que obedecem a regras precisas podem ajudar
I'mvestigador a determinar se as diferengas entre as distribuicdes de

ariaveis s3o estatisticamente significativas.

‘roporcao e percentagem

ando o investigador estuda distribuicdes de tamanho idéntico, os dados
le frequéncia podem ser utilizados para fazer comparagdes entre grupos.
5 entanto, de um modo geral, ‘quase nunca é possivel estudar
distribuicBes que apresentem o mesmo nimero de casos. Por exemplo,
ma amostra retirada da populagdo em geral, o nimero de mulheres

nca sera igual ao nimero de homens.

Assim, torna-se necessario um método para padronizar distribuicbes de
frequéncia pelo tamanho - uma forma de comparar grupos, sem ter em
sonta as diferencas em termos de frequéncia. A proporgdo e a percentagem

=5 dois dos métodos mais comuns e mais uteis para comparar

listribuicdes.

propor¢cdo compara o nimero de casos em determinada categoria com 0
=nho total da distribuicdo. Podemos transformar qualquer frequéncia

a proporgdo dividindo o nimero de casos numa categoria arbitraria

selo nimero total de casos na distribuiggo.

~aso se prefira indicar o tamanho relativo de uma série de nimeros atraves
da frequéncia de ocorréncia de uma categoria por 100 casos, utiliza-se a

percentagem. Para calcular uma percentagem basta multiplicar por 100

qualquer proporgao dada.

21




A construcdo dos instrumentos de recolha de dados

Recolher informagdo implica um grande esforco por parte do investigador
social que procura ampliar o seu conhecimento sobre o comportamento
humano. Inquirir pessoas exige previsdo, planeamento cuidadoso,
conhecimento de um conjunto de aspectos técnicos sobre o processo e as

condigdes de recolha e, logicamente, tempo.

Elaboracdo do inquérito por questionario

Construir um bom inquérito por questionério depende ndo s6 do

conhecimento de técnicas mas também da experiéncia do investigador.

Seguir um método é essencial, pois identifica as etapas basicas envolvidas
na construgdo de um instrumento eficaz. Ao escolher o inquérito por
questionario como instrumento de recolha de dados o investigador deverd
respeitar um conjunto de procedimentos comum a qualquer processo de
investigacao:

definir rigorosamente os objectivos;

formular hipéteses e questdes orientadoras;
identificar as varidveis relevantes;

seleccionar a amostra adequada de inquiridos;
elaborar o instrumento em si;

testa-lo (pré-teste);

administra-lo;

2 oy B g T B

analisar os resultados.

Uma das caracteristicas que distingue o inquérito por questionario de
outras formas de inquérito (por exemplo, inquérito por entrevista) reside
no facto de investigador e inquiridos nao interagirem, necessariamente, em
situacdo presencial.

Esta caracteristica constitui o problema-chave que surge na elaboragédo e

aplicacdo de um inquérito por questionario. Assim, deverda haver muito
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cuidado no que diz respeito a formulagdo das perguntas, pois ndo havera

possibilidade de esclarecimento de duvidas no momento da inquirigao.

Cuidados a ter no processo de recolha de dados: a questdo da
fiabilidade

Regra geral, a técnica do inquérito por questiondrio é bastante fidvel desde
que se respeitem rigorosamente os procedimentos metodoldgicos quanto a

construcgdo, seleccdo da amostra e aplicagdo.

Erros no processo de investigacao

Num processo de investigacdo podem ocorrer dois tipos de erros.

Erros amostrais - relacionados com falhas nos processos de seleccdo da

amostra e do calculo do seu tamanho.

Erros ndo-amostrais - inimeras causas, entre elas, elaboracdo defeituosa
de questiondrios com questdes tendenciosas ou dubias, ou ainda a escolha
ou uso incorrecto de escalas de medigdo. O processo de recolha de dados
ocorre sempre em situagdes complexas, onde diversos factores influenciam
as caracteristicas que se pretendem medir, podendo gerar erros nao

amostrais.

Explicacdao da variacdo entre resultados individuais

Num instrumento de medida aplicado a um grupo de pessoas, a variagao
entre as respostas pode explicar-se por um certo niumero de factores: por
um lado, parte da variagdo pode ser entendida como resultante de
diferencas reais, entre os individuos, quanto a caracteristica que esta a

ser medida; por outro lado, explica-se por erros no processo de inquirigao.
O problema bésico na interpretacdo de resultados de qualquer estudo € o de

definir e distinguir entre diferencas reais na caracteristica medida e

diferencas devidas a erros no processo de inquirigao.
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Possiveis fontes de variacdo nos resultados, num grupo de
individuos

1. Diferengas verdadeiras na caracteristica em analise. Num plano ideal,
todas as diferencas encontradas através de um processo de recolha de
dados utilizando o questiondrio podem referir-se, exclusivamente, as

diferencas reais quanto ao que se pretende medir.

2. Diferencas reais noutras caracteristicas relativamente estaveis do
individuo, influindo nos resultados. O investigador social dispde de poucas
técnicas que permitam medidas puras de qualquer caracteristica que seja.
Resultados obtidos num grupo reflectem ndo apenas diferengas na
caracteristica que estd a ser medida, mas também diferengas em variaveis
tais como grau de formagdo, inteligéncia, personalidade; as quais

contaminam os resultados do questionario ou as avaliagdes do investigador.

3. Diferencas devidas a factores pessoais passageiros, tais como disposigado
momentanea, cansaco, salide, distracgdo, motivagao, interesse pelo tema

do questionario, etc.

4. Diferencas devidas a factores de situagdo. Frequentemente, as diferencas
na situagdo em que ocorre a recolha tém um importante papel nas

diferengas de resultados entre um grupo de individuos.

5. Diferencas devidas as variagbes na aplicagdo. Métodos inadequados ou
ndo-uniformes de aplicagdo de um questionario podem contribuir para

variagdes nos resultados.

6. Diferengas devidas a amostragem de itens. Por melhor que seja um
instrumento de medida, provavelmente ndo sera capaz de abarcar todos os
itens do universo de itens significativos para a caracteristica que estd a ser

medida.
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Falta de clareza do instrumento de medida. As diferengas nas respostas
em significar diferencas de interpretagdo do instrumento, e nao

rencas reais nas caracteristicas que estédo a ser medidas.

Questionarios mal elaborados. Com questdes tendenciosas, dubias, e/ou

uencialmente mal posicionadas.

ivinha-se, portanto, a importancia de um questiondrio bem construido e
aplicado, garantindo significativa redugdo no nivel do erro nao

ostral.

Componentes do questionario

Tipos de perguntas

O conjunto de perguntas que constituem um inquérito por questionario tera
de ser cuidadosamente organizado. Para ser eficaz, o questionario sera
organizado por tematicas claramente definidas. Regra geral, um

. guestionario integra os seguintes tipos de perguntas:

1. Apresentagao. E importante motivar o inquirido através de uma prévia
exposicdo sobre a entidade que estd a promover a pesquisa e sobre as
vantagens dessa pesquisa (para a sociedade ou para o inquirido, se for o
caso). Assim, apresenta-se nesta fase o investigador ou a equipa de

investigagdo, o tema e os objectivos do estudo.

2. Instrucdes. As instrugdes para o preenchimento do questionario podem
ser claras e objectivas ao nivel de entendimento do inquirido e ndo somente

ao nivel de entendimento do investigador;

3. Identificacdo do inquirido. Neste ponto recolhe-se apenas 0 nome ou uma
identificacdo béasica do inquirido (sexo, idade), remetendo os seus dados
gerais de caracterizacdo (perguntas de classificagdo do inquirido) para o
final do questiondrio (profissdo, habilitacdes académicas, rendimentos,

etc.);
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4. Informagbes solicitadas. Perguntas sobre aquilo que se pretende
investigar. Tém por objectivo recolher dados sobre factos e opiniGes do
inquirido;

5. Perguntas de controlo. Questbes que se destinam a verificar a veracidade

de outras perguntas inseridas noutras partes do questiondrio;

6. InformagGes de classificagdo do inquirido. Os dados de classificacdo do
inquirido, regra geral, podem estar no final do questionario. Pode ocorrer
distorcdo se estiverem no inicio porque o inquirido podera alterar as
respostas, caso os seus dados pessoais ja tenham sido revelados no inicio

do questionario.

Etapas para a elaboracdo de um questionario

Para se elaborar um questionario respeitar-se-8o as seguintes etapas:

1. Estabelecer uma ligacdo com:

O problema e os objectivos da investigagao;

As hipoteses da investigacdo:

A populacdo a ser investigada;

Os métodos de anélise/tratamento de dados escolhidos e/ou

disponiveis.
A construgdo do questionario esta ligado a formulagdo exacta do problema a
ser investigado e ao objectivo da pesquisa. As perguntas que virdo a
constituir o questionario fluirdo naturalmente, neste momento do processo,
desde que as etapas precedentes da pesquisa tenham sido meticulosamente
seguidas.

2. Tomar as decisSes referentes aos seguintes pontos da pesquisa:

Conteudo das perguntas;
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Formato das respostas desejado;
Formulacdo das perguntas;
Sequéncia das perguntas;
Apresentacgao e lay-out;

Pré-teste.

Decisbes para a elaboragdo do questionario

Decisdes sobre o contetido das perguntas

No que diz respeito ao conteudo, distinguem-se duas grandes categorias de

guestdes:

1. Aquelas que se debrugam sobre os factos, em principio susceptiveis de
serem conhecidos de outra forma sem ser através de um inquérito. (Ex.

Idade? Local de trabalho? Destino das ultimas férias, etc.)

2. Aquelas que se debrucam sobre opinides, atitudes, preferéncias,
sentimentos, crencas sobre factos, padrées de comportamento, etc. (Ex. O
trajecto para o seu local de trabalho é cansativo? Porque passou férias

nesse local?)

Destes itens, os mais dificeis de medir s&o os relativos a opinibes, atitudes,
sentimentos e crencas quanto aos factos. Por serem muito intimos e
pessoais, os inquiridos nem sempre estdo dispostos a revela-los.

E sempre necessario que o investigador coloque a si proprio questoes do
tipo: a pergunta é mesmo necessaria? Que tipo de resposta vou obter? Para
que servira a resposta? Como sera tratada?

Estas perguntas podem desdobrar-se nas seguintes questoes?

1. O assunto tratado exige uma pergunta separada ou pode ser incluido
noutras perguntas?
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2. Existem outras perguntas que ja incluem adequadamente este ponto?

w

. A pergunta € desnecessariamente minuciosa e especifica?

4. S3o necessarias vérias perguntas sobre o assunto ou basta apenas uma?

u

. Cada pergunta trata de um sé assunto?
6. Foram evitas as abreviaturas?

7. A formulacdo da pergunta ird permitir que a resposta forneca a
informagao pretendida?

8. Nas perguntas de opinido, interessa conhecer o grau em que o inquirido
é favoravel ou desfavorével, ou basta saber se é a favor ou contra?

9. Os inquiridos tém a informagdo necesséria para responder a pergunta?
Sao capazes de lembrar-se adequadamente dela?

10. Os inquiridos estardo dispostos a dar a informagdo?
11. Que objecgdes poderdo ter os inquiridos na resposta a esta pergunta?

12. O tema abordado € muito intimo, perturbador ou expde socialmente as
pessoas, de forma a provocar resisténcias e respostas falsas?

13. O tema é embaracoso por, que coloca em perigo a imagem, do inquirido
caso seja contrario a ideias socialmente aceites?

14. Podera a pergunta ser mais concreta, especifica e mais directamente
ligada a experiéncia pessoal de quem responde?

15. O conteldo da pergunta é suficientemente geral?

16. O conteldo da pergunta ndo pbderé vir a enviesar a resposta?

Como evitar o enviesamento das respostas?

Esta pergunta pode desdobrar-se nas seguintes questoes:

1. A pergunta é suficientemente neutra, para no influenciar as respostas?

2. Pessoas com opiniGes contrdrias sobre o assunto ndo a considerario

tendenciosa?
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3. A pergunta contém opinides ou julgamentos relacionados com o assunto?

4, A pergunta contém termos carregados de afectividade, juizos de valor ou
conotacdes diversas que possam modificar o sentido da questdo e,

portanto, das respostas?
Outros aspectos/questdes referentes a redaccao das perguntas:

1. A pergunta podera ser mal compreendida? Contém frases ou termos

dificeis e/ou obscuros?

2. Os termos utilizados serdo bem compreendidos? Termos especializados
usam-se apenas quando sdo realmente necessarios, pois 0 sentido, devera

ser claro para todos.

3. A pergunta é curta e simples? Perguntas longas e dificeis tendem a ser

mal compreendidas.

4. Existe indefinicdo ou ambiguidade? Que outros sentidos podera ter a

pergunta para quem responde?

5. Existe énfase ndo intencional numa palavra ou frase susceptivel de

mudar o sentido da pergunta?

6. A pergunta exprime adequadamente todas as alternativas, ou mostra
apenas um dos lados do tépico em questdo? Ambos podem ser referidos.

7. O quadro de referéncia é claro e uniforme para todas as pessoas que nao

responder?

8. A pergunta deixa claro que o inquirido pode respondé-la baseado naquilo

que pensa ser a verdade e ndo naquilo que desejaria que fosse a verdade?

9. O que trard melhores resultados? Uma redacgdo mais pessoal ou mais

impessoal da pergunta?
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10. O que sera melhor? Apresentar a pergunta de maneira directa ou

indirecta?

Decisoes sobre o formato das respostas

Para além da classificagdo segundo o contel(ido, as questBes também se
podem distinguir pela sua forma. Assim, quanto ao seu formato, as

questdes podem ser:

1. QuestGes abertas, as quais o inquirido responde como quer, utilizando o
seu proprio vocabuldrio, fornecendo os pormenores e fazendo os
comentarios que considera certos, sendo aquilo que diz integralmente

anotado pelo entrevistador ou registado pelo inquiridor.

2. Questdes fechadas (ou de escolha mudltipla), o que permite ao inquirido,
seleccionar numa lista pré-estabelecida de respostas possiveis a que melhor

corresponde a questao.

3. Questbes dicotémicas, que apresentam apenas duas opcoes de
respostas, de caracter bipolar, do tipo: sim/ndo; concordo/n&o concordo;

gosto/ndo gosto.

A escolha do formato mais adequado das perguntas e das respostas devera
ter em conta as vantagens e desvantagens de cada tipo para o objectivo da

pesquisa.

DecisSes sobre a Formulagdo das Perguntas

Na formulagdo das perguntas, ter-se-a cuidado para que essas tenham o
mesmo significado para o investigador e para o inquirido, evitando-se assim

um eventual erro de medicdo.
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 formulacdo das perguntas tem efeito sobre as respostas. Esse efeito pode

avaliado comparando-se os resultados em sub-amostras, de perguntas

uladas de forma diferente.

2ecomendacdes sobre a formulagado das perguntas

perguntas que compdem o questionario deverao:

Ser reduzidas;
Ser fechadas sempre que possivel;
3 Ser formuladas em linguagem simples e palavras conhecidas;
.. Confirmar-se mutuamente;
Abranger todos os pontos a questionar;
N&o conter palavras/conceitos ambiguos.
7. Evitar qualquer sugestdo de resposta;
. Evitar contetdo afectivo, emocional e/ou sentimento de aprovagao ou
reprovacao;
9. Evitar contelidos alternativos implicitos;
_ Evitar a necessidade do inquirido fazer calculos para responder;
1. Evitar possibilidade de dupla resposta;
Evitar indiscricbes gratuitas;
Ser pertinentes relativamente a experiéncia/conhecimentos do
quirido;
14, Evitar a ligagao entre os temas;

15. Evitar o contagio de respostas;
16. Evitar enviesamentos involuntarios, motivados por reacgao visando

prestigio por parte do inquirido; retraimento defensivo diante de perguntas
personalizadas ou ainda, atraccdo exercida pela resposta positiva ou

socialmente correcta.

Ao formular as perguntas o investigador deve ter em mente as seguintes

condicionantes das respostas:

1. Procura de conformidade ao grupo;
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. Tendéncia de imitagdo social;

. Medo do julgamento social;

. Procura de prestigio social;

. Participacao nas emocgdes colectivas;

. Submissdo aos esteredtipos culturais;

N oo A WN

. Medo face a mudanga.

Decisdes sobre a sequéncia das perguntas

A sequéncia pela qual as perguntas sdo apresentadas podera ser crucial

para o sucesso da investigagdo, pelo que revela-se importante:
1. Adoptar uma ordem ldgica das perguntas;

2. Dar, uma sequéncia légica ao questionario, evitando mudangas de temas

repentinas e "ir e voltar" ao assunto;

3. Usar temas e perguntas gerais no inicio do questionario, deixando as

perguntas especificas para depois (vai-se fechando o foco gradualmente);

4. Apresentar perguntas de cardcter mais invasivo, perguntas mais
pessoais, delicadas, sensiveis ou embaragosas somente no final do

questionario, alternando-as com questdes simples;

5. Apresentar informacdes que classificam social, econdmica ou
demograficamente o inquirido no final, do inquérito, com excegdo das que

funcionam como "filtro".

Aplicacdo do questionario

Um dos problemas associados ao inquérito por questionario auto-preenchido
é a elevada taxa de ndo-respostas. Apresentam-se de seguida factores

condicionantes da ndo resposta com a respectiva justificagdo.
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1. A natureza da investigacdo (as pessoas tendem a

percebem a utilidade da investigagao).

tém maior tendéncia para colaborar em inquéritos por questionario). il

3. O conjunto de perguntas (quanto mais claras e objectivas forem as

guestdes, maior a probabilidade de resposta) e o tamanho do questionario.

4. As instrucbes (quanto mais facil for preencher o questionario, maior a

probabilidade de resposta).

5. Reforco/recompensa (a explicagdo dos objectivos e a legitimagdo da
utilidade do estudo, a informagdo sobre como e para que serdo usados o0s
dados recolhidos e ainda uma eventual recompensa, normalmente,
aumentam a taxa de respostas).

Outra preocupagdo com o questionario é a de explicar as condicdes
adequadas para o seu uso e aplicagdo, tanto no caso de formularios auto-
preenchidos quanto nos que utilizam inquiridores. Quando se recorre a
inquiridores, podem ser fornecidas instrucBes claras de como proceder no
terreno, como abordar os inquiridos, como preencher os instrumentos, etc.

Eis alguns aspectos a serem respeitados pelos inquiridores:

1. Proporcionar ao inquirido uma situacdo de liberdade, em que seja

estimulado a apresentar francamente as suas opinides;
2. Garantir, se for o caso, o anonimato do inquirido;
3. Ser educado, correcto, amistoso e imparcial em relagdo ao inquirido;

4.Evitar mostrar surpresa ou desaprovacao diante das opinidbes de quem

responde;

33



5. Apresentar as perguntas de maneira exacta, com as mesmas palawr

que foram propostas;

6. Nao fornecer qualquer explicagdo improvisada da pergunta no momes
do inquérito. Em casos em que se antecipe, o surgimento de davidas,

esclarecimentos devem ser previamente elaborados;

7. Colocar as perguntas em funcdo da ordem em que aparecem &

questionario;

8. Apresentar todas as perguntas sem nunca responder a alguma

deducdo propria;
9. Registar fiel e integralmente a resposta;

10. Saber, por exemplo, como proceder em casos de recusas ou auséncia:

dos inquiridos.

Decisdes sobre a apresentacdo e o desenho do questionario
(caracteristicas fisicas)

O questionario, sobretudo quando se destina a ser preenchido pelo prépris
inquirido € deve ter um grafismo cuidado. S&o aspectos importantes nesta

fase:

1. Numero de péginas;
2. Tipos e tamanho de letra;
3. Posicionamento e tamanho dos espacos entre questdes;

4. Cores da tinta e do papel para as respostas;

(9]

. Espacgo para resposta de cada questdo;
6. Separagdo de campos para facilidade de digitacdo (praticamente‘
obrigatéria para reunir as respostas e processé-las em tempo reduzido); 3
7. Qualidade do papel e da impresséo;

8. Impressdo em frente e verso ou sé na frente.
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stes aspectos sdo relevantes para S€ conquistar a colaboragdo dos

or e mais adequada for a apresentagdo, do
evar o indice de respostas.

Quanto melh

érito, maior serd a probabilidade de se el

.cisdes relativas quanto ao pré-teste

do em conta a complexidade que envolve a construgdo de um
4vel que o investigador ndo consiga prever todos 0s

r durante a aplicagdo do mesmo.

Juestionario, € prov
sblemas e/ou davidas que podem surgi

Dai a importancia de realizar um pré-teste. Trata-se de
instrumento de recolha de dados

um ensaio geral

-ra verificar como se comporta 0

construido, na situagao real.

do pré-teste, pode significar grande perda de tempo,
fique algum problema grave com O

A ndo realizagao
dinheiro e credibilidade, caso se veri
guestionario ja na fase de aplicagao.

Indicadores de anomalias no questionario que poderdo ser objecto de

alteracBes por parte do investigador apds o pre-teste:

1. Respostas sem logica;

2. Respostas estereotipadas (a “boa” resposta);

3. Grande proporgdo de respostas do tipo "ndo sei" ou "ndo compreendo”,

“outra resposta”;
ande numero de especificacoes ou comentarios adicionais;

o substancial das respostas quando se muda a ordem das

6. Elevada proporcao de respostas recusadas.
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Em relagao ao pré-teste, recomenda-se:

1. Os inquiridos podem pertencer a populagdo alvo da investigagao e devem

ter tempo suficiente para responder todas as questoes;

2. Os entrevistadores devem ser experientes/treinados;

3. O investigador pode utilizar diferentes meios de avaliagdo, tais como
discussdao em grupo;

Em relacdo aos elementos funcionais do questionario, pode-se verificar no
pré-teste:

1. A clareza e a precisdo dos termos utilizados;

2. A eventual necessidade de desmembramento das questdes;

3. O formato das perguntas;

4. A ordem das perguntas;

5. A introdugao;

6. Avaliar o valor de cada pergunta.

Caso o pré-teste revele a necessidade de muitas alteragdes, o questionario
revisto poderd ser novamente testado. O processo sera@ repetido tantas

vezes quantas forem necessarias, até que o instrumento se encontre pronto

para ser aplicado.
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Parte II - Iniciar o SPSS

Para iniciar o SPSS premir o botéo Iniciar > Todos os programas > SPSS

&)

Figura n®1 - Iniciar SPSS

Quando iniciar o SPSS visualiza-se uma janela com opgbes do que se pode

fazer:

e Run the tutorial
Correr um tutorial sobre o SPSS;

e Type in data
Abrir a drea do SPSS para insercdo de dados;

e Run an existing query

Abrir um ficheiro existente;

o Create new querusing Database Wizard
Criar um ficheiro no SPSS usando uma base de dados;

e Open an existing data source

Abir um ficheiro do tipo SPSS (.sav) ja exstente.

* Open another type of file

Abrir um ficheiro de outro tipo, como por exemplo Excel (.xls)

Apos a seleccdo de uma opgéo, premir o botdo de OK.

4 Para ter acesso aos ficheiros utilizados neste documento pode consultar o eﬁder‘ego
http://www.eses.pt/bases_dados/publica.asp
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Janela de dados (SPSS Data Editor)

= exemplol - SPSS Data Editor
Barra de menus

Fle Edt View Data Transform Analvze Graphs Utiities Window Help :
81618 o[ 5 clb] & EE EEF SQf] T[> oo e ferements
1 2 | & | 6 | MEre i A
[ 2 1. @1 0 | BN J--8 Fowcd 3  Grelha de ediglo
1 8 | 8 § SN f - 4o 1 de dados
! B ¥ | BN
& - - T
I T L5
2 | = 0 2

Barra de estado

Figura n°2 - Janelas de dados

Modo de visualizagéo e

Modo de visualizagdo e DD e e

alteracdo de dados

Data View -nesta janela as linhas representam casos (dados de resposta
a um questionario obtidos junto do inquirido) e as colunas representam as

variaveis (as perguntas que estdo colocadas no questionario).
Variable View - nesta janela as linhas representam a definicdo das

varidveis e as colunas representam os titulos dos contelidos descritos no

questionario.
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Barras de ferramentas

Menu de procedimento de tratamento estatistico
de dados

Menu para transformagéo de variaveis Menu para construgdo de graficos

Ez3 AML survival - SPSS Data Editor
File Edt View Data TIransform Analyze Graphs Liities Window Help

&(@|@| B o 1) x| el El| DEE %ol

- nt;:.m M

Abre uma nova Gravar a Imprime a “Go to Descreve as Insere Insere
base de dados base de base de case” variaveis casos variaveis
dados dados

Mostra as etiquetas atribuidas aos valores de
uma variavel

Figura n°3 - Barras de ferramentas

Barras de Estado

Esta barra encontra-se na parte inferior do ecra.

Figura n°4 - Barra de Estado

39




Menus

File

FuncOes de criar, abrir, ler ou imprimir

Edit

Fungdo de modificar, copiar, pesquisar dados e realizar a parametrizagao
de opcodes diversas.

View

Funcdo de activacdo de barras de botdes, fontes, grelha, barra de status ...

Data

Funcbes de alteracao global dos dados, tais como: transpor varidveis e
casos, criar subconjuntos de casos para analise, inserir dados.

Transform

Funcgdes de alteracbes nas variaveis seleccionadas, e de calculos de novas
variaveis a partir de valores de outras jd existentes.

Analyze

Fungdes de andlise estatistica, como analise descritiva, analise de
variancia, correlacoes, regressdes lineares, etc.

Graphs

Fungdes para criagdo de graficos, de colunas, de sectores, histogramas,
etc.

Utilities

Fungdo para obtencdo de informacg@o acerca das variaveis, controlo da lista
de variaveis que aparece nas caixas de didlogo, dinamizacdo do scripts
(pequenos programas) e alteracdo dos menus.

Window

Funcdo que permite a troca da janela em visualizacdo.

Help

Funcdo de ajuda relativa ao SPSS. Ligacdo a pagina do SPSS na Internet.

Definicao de variaveis
Para definir as varidveis posicionar-se na janela Variable View. Nio

esquecer que cada linha corresponde a uma variavel.

il ool By L] n s el el EEILHTS G il :
‘ Tope | wan | Dwsionun fvahe | ebe | o | e ] aikgs | messie |

i
{
i
7

TS TR T v s Voo ST T =

Figura n°5 - Definicdo variaveis
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interface inscrevem-se os seguintes elementos:

Nome da variavel

Tipo de varidvel (numérico, texto, data, etc)

Tamanho da variavel

Numero de casas decimais

Descricdo da variavel

Valores da variavel

Definicdo de valores em falta

Columns Tamanho da Coluna

Formato de apresentacdo da variavel (esquerda, direita, centro)

Align

Measure Definicdo da escala de medida da varidvel (Scale, Ordinal, Nominal)

A titulo de exemplo definem-se todas as variaveis do anexo 1%
Nome da varidvel: Leitura_Hiperdocumento
Tipo: Numeérico
Tamanho: 8
Casas decimais: 0
Label: Leitura_do_Hiperdocumento
Values: 1 - Lé o ecra
2 - Imprime
3 - Formato misto
Missing Value: 9

Para definir o tipo pressionar os trés pontinhos que aparecem quando se
estd posicionado na célula do tipo da varidvel. Optar por “numeric” se a

variavel for numérica ou por “string” se a variavel for de texto.

5 Atencdo: o nome da variavel ndo pode conter espagos
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Name |  Type | Width | Decimals |
Leitura_Hiperdocumentao {Numeric 8 [Le
[ ! ¥

i
I

da variavel e

1
2
3 _
- —
g % Numeric SR == prima OK
7
8

r Dot Cumi .
_____: r‘smm r ___‘:'_?;___
9| ot '
1 - " Dollar i
1 @ Cmnqm
12 C Suing
13 - I

Figura n°6 - Tipo variavel

Para definir os descritivos dos valores das varidveis posicionar-se na célula

do Values Labels e premir os trés pontinhos.

| e T ]} Values :
[Leitura do Hiperdocumento Cumprimento do Ojectivo {1, 16 0 ecré].. )

S— e | abels
M e
| vahe: | | ceneel | |
i  Value Label: [Ié 0 eci3 b B
A——— _% £
Lts s ; 5
— | 2

Figura n°7 - Values Labels

Quando se utiliza a janela anterior inserir o valor e o seu descritivo,

conforme o exemplo e premir o botdo Add e OK.

Apos definicdo da varidvel, copid-la e cola-la na linha seguinte. Esta
operagdo permite uma rentabilizacdo do tempo pois na definicdo de outra
varidvel bastara alterar o nome. Para copiar, clicar em “label” com o botdo
direito do rato e optar por copiar. Para colar, posicionar-se na linha “label”
onde pretende efectuar a colagem, premir o botio do lado direito do rato e
premir colar.
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=1 Untitled - SPSS Data Editor
Fiie Edt View Data Transform Analyze Graphs Utiities ‘Window Help

e DI @
| width | Decimals

T

Figura n°8 - Copiar Variavel

Introducdo de Dados

Introdugao de Dados

Apos definir todas as varidveis posicionar-se na janela de Data View e

serir os dados correspondentes a cada varidvel criada anteriormente.

ta Editor — Data View
nela onde se insere, altera e apaga os contetdos do ficheiro de dados.
5 € possivel manter aberta uma janela deste tipo.

Variaveis

Figura n°9 - Casos - Variaveis

Cada uma das linhas da tabela corresponde a um caso. As colunas

correspondem as variaveis anteriormente inseridas.
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Inserir novos casos

=of]
2

Para inserir um novo caso, premir o botdo -, ou posicionar-se na

pretendida e inserir os dados.

Copiar casos

Para copiar os casos clicar com o botdo direito do rato e premir copias

Seleccionar a linha onde se pretende colar e premir o botao de colar.

Uonteudo_interes| LONeuao_int
se_Cumprimento sse_Demons::I
Qbiectivo | do )
1 Suficiente | i
Suficien

Figura n°10 - Copiar Casos

Alterar casos

Para alterar um caso posicionar-se na célula que se pretende alterar, editar
a célula através de dois cliques e alterar o valor pretendido, ou entdo fazer

a alteragdo na area superior, conforme figura seguinte.

| Conteudo_interes| Contedda_intere[ Conteudo_|
se_Cumprimento | sse_Demonstra| nteresse_C

1 Suficiente ¥]  Insuficiente| Suficiente| Suficiente| Suficiente Suficiente| Suficients
2 ~ Suficiente] Insuficiente| Suficiente| Suficiente| Suficiente| Suficiente Suficients

Figura n°11 - Alterar Casos
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Apagar casos

Para apagar uma varidvel clicar com o bot&o direito do rato sobre a linha

que se pretende apagar e optar por Clear.

Comeudo Intere| Conteddo_I| Conted
se_Cumprimento| sse_Demonstra| nteresse_ C Clareza

Qhiectivo do
1 Suﬁcaente Insuficiente |  Suficiente  Sufich

Corrteudo Interes

Figura n°12 - Apagar Casos

Inserir novas variaveis

Para inserir novas varidveis, posicionar-se na coluna a direita da coluna

onde pretende criar as varidveis e clicar no botado -ﬁ—?; ou clicar com o botdo

direito do rato sobre a coluna pretendida e premir Insert Variables.

Contetido_ [ C=tonda i Fantaadan g

Clareza CofC <t
Copy

| Suficiente
| Suficiente

Figura n°13 - Inserir Variavel

Procurar informagao

Para procurar um caso, optar por: Data > Go to CaseL
Para procurar dados optar por: Edit > Find /inserir o cursor na coluna onde

se encontram os dados/inserir o dado pretendido/clicar em find next.

Filtrar dados

Posicionar-se na janela do data view. Se se pretender filtrar os dados, ou

seja, seleccionar dentro de um conjunto de acordo com uma condigao

entdo... optar no menu por data/select cases ou clicar no icon jﬁ_l Select

Cases da barra de ferramenta, depois seleccionar a opcao desejada: todos
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os casos, condicdo satisfeita, varidaveis de filtro, baseado em

aleatdrios ou em tempo.

Currert Status: Do not filter cazes.

[[OK | Paste | Reset | Cancel| Hep |

Figura n°14 - Filtrar casos

Como exemplo, seleccionar a opgao If condition is satisfied e premir o

ardelido

ABS{rumexpr]

£l _0 L1 patiinmes, pro | Musto Bom
21 (1] _Dekete | {cor gERNOULLIGS) % bm Bom
bm Bom

[Continue | Cancel | Hep | b Sucients

Figura n215 - Definigdo de condicao

Seleccionar a variavel (ex.Conteudo_Compreensdao_Cumprimento_
Objectivo) e depois clicar na seta e indicar a condigao (ex.: pretende-sa
sejam indicados os conteldos_compreensao_Cumprimento_Objectivo
a 3, ou seja, que sdo suficientes). Depois premir o botdo Continue.

Na nova interface optar por OK.
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ADOS [ED.sav \I“n Data Editor

[T1 L= i | 10 - . i! | i
Suficients Suﬁctanta i i
Bor ~ Bom  Suficiente| Suficiente| Suficiente| . Bom| B
ient ficiente jente | 'S'_t_;ﬁéi_s'&"fé' Suficiente Té?ﬁﬁés_nte T i
""" " Bom| jente| Suficiente " Bom | Suficiente|Inst
s m| Suficiente Suficiente | fSuficiente | =
:—_" ‘Bom _' 'vgiif;_réﬁie Insuficiente :__'w_Bﬂbm Tciente. ﬁ_&i@; | St
~_Bom Bom Bom Bom| St
Bom ~ Bom Bormn T Bom| Bom|
— o !“Lﬁ?_ e —om| ﬂ&‘ﬂjﬁ_ﬂ‘ S "E'!Emi
“Bom|  Bo '“S_udfii:_i;mel Bom | _Bﬁ_n?t:w Muito Bom | Muito Bam Mui
o i Bam Moo Bom Wi Bom| o Bom | Moo Bom|___Bom | M

................ s i
Bom ___.L__.__Em___,__m ___Bom| Bom Bom|
__ Bom _ﬂ_'___.,._,.FE"EL,.,._.,_ﬁ_":!?T‘_ _______ Bom _Bom|
? Bom | w__E:im_ Suficiente ciente | _Bnmi St

Figura nUiG - Filtro

Como se pode observar as linhas cortadas nao correspondem & condigao

‘escolhida.

Como retirar os filtros?

Clicar no icon F3|, e na janela que surge, escolher a opgdo visualizar todos

os casos e premir OK.

Figura n°17 - Retirar filtro

Gravar um ficheiro de dados

Para guardar os dados inseridos, ir ao menu File e premir Save.
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Abrir um ficheiro de dados

Para abrir um ficheiro de dados ja existente ir ao menu File e clicar em

Open, ou premir o botao il na barra de ferramentas.

Open File

Procuaren | € 07112005 T ] - Bk

I)Enviado
gecm_omos_ﬁb‘m
| variaveis_ECM_DADOS_ED.sav

Nome do fichero: |

Ficheios datip:  |SPSS [*sav) =] _ P |
T ]

Figura n°18 — Abrir ficheiro

Entre os ficheiros mais utilizados ha, por exemplo, os de tipo SPSS (.sav), e
os de Excel (.xls). Se o ficheiro for de Excel deve se proceder da seguinte
forma:

Bl (3_1

él;ﬁlaﬁl T bJ | ilr'*i f‘i'lﬁiﬁl ’_—J_i

Seleccionar o
ficheiro de Excel

— | SR T e e ___*i

I

e
3

|
i
1 |
1 i
|
{

= Premir Abrir

Ape—

{ Nome do ficheio: |Disciping ks

——proms oo [Eeat T

Escolher o tipo de
ficheiro Excel

£ 5

g

&

o

Figura n®19 - Abrir ficheiro Excel

1 Escolher o tipo de ficheiro;
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2 Seleccionar o ficheiro de Excel que contem os dados que se
pretende utilizar no SPSS;

3 Premir o botdo Abrir.

No ecra que surge premir OK

Graphs - LRltes  Winde i

grm  CAnehyre

ﬁ — s
1 s

; 1

e —

z ....... L B Opening Excel Data Suurrr

| e — : IRS——— E\ESES“‘ 10 11 s

=  EE sl —M‘D"”"""‘

; ¥ Read variable names from the first row of data.

. i Worksheet [Folhal [ATE3] =1 L

10 e S Ao

7S é s ;

12 i

— Premir OK .

13 ﬂ_l - Cancel _] H* I .........

14 deasisy B e eSS e == > . — _

Figura n°20 - Abrir Ficheiro Excel

Frequéncias

As frequéncias permitem conhecer o numero de incidéncias em determinada

variavel.
Para conhecer o nimero de alunos trabalhadores/estudantes de uma turma

e o nimero de alunos que ndo correspondem a este estatuto, considerar-

se-a o seguinte exemplo:

Disciplina.sav - SPSS Data Editor
Fle Edt View Data Transform Analyze Graphs Ltiities Window Help

=@|8| | o | x| 0| 8 Fr| TEE

| Nome | idade Sexo Estatuto_ | Nota Trabalho| Nota Testa—l— —_[:
1|Jodo ? 2 Masculma Trabalhador/Estudante ' 12/
2Tania | 21 Femmlnu 1 " Estudante, _1_4_
3|Manuel | 21 Masculino | Estudante| 70 i
SlRite || 22 Féi’nimnn 1 Estudante 8 T
5lJoana | 23 Femmmo ' Tr_g;:alhadorfEstudan{; ) 10 s o
? i T e — S — —

Figura n°21 - Exemplo

Na janela do data view verificar se a etiqueta “value label” esta activada de

forma a visualizar a coluna do estatuto com a indicagdo “estatuto”. Depois ir
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ao menu Analyze > Descriptive Statistics © Frequencies. Seleccionar a
variavel Estatuto que se encontra na Lista de varidveis fonte, clicar na seta
que se encontra entre as duas listas. A varidvel Estatuto passa entdo para a

Lista varidveis de destino. Premir o botdo OK.

R e

EE T —

Notz Tra

~. Lista de varidveis
™~ destino

_ variaveis
- fonte

Figura n®22 - Frequéncias

Sempre que um determinado procedimento gera resultados,abre-se
automaticamente uma nova janela, designada de Output View, onde sao

apresentados os resultados estatisticos, tabelas e gréaficos.

e
Notes QFTGQUODCIQS
Statistics
s . 4N° alunos
Statistics por
Estatuto estatuto
N Valid
" | o
Estatyito
Cumulative
Fmggsncr Parcent | Valid Percent Percant
Vald  Estudanis 3 60.0 60,0 60,0
TrabslhadorEstudante | 400 400 100,06
Total 5 100,0 100,0

Figura n©23 - Output Frequéncias

Como se pode observar na imagem existem 2 “estudantes trabalhadores” e
3 “estudantes” num universo de 5 pessoas, o que equivale a uma
percentagem de 40% para 60%.
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Para obtermos a Média

Para calcular a média das notas dos trabalhos dos alunos do exemplo
anterior, procede-se do modo seguinte:

Optar novamente por Analyze > Descriptive Statistics & Frequencies. Nesta
janela, retirar a varidvel “estatuto” pré-seleccionada no exercicio anterior.
Para isso, existem duas opgdes. A primeira consiste em clicar duas vezes na
variavel “estatuto”. A segunda consiste em seleccionar a varidvel e clicar na
seta do meio. Esta varidvel muda entdo directamente para a lista de

variaveis Fonte.

&
g

_Mgml : M |- Sexs | Estatuto | Mota_Tr: Nota Teste |
1}Jodo
2|Ténia &

e

4|Rita
5Juaﬁs =ik
: =

7
g
2] |

';a

ST
12
B
14

5]
16]
| iSidabeg kb ; o .

il . - —  Staiwties | Chate. | Fomat | |

18 | S — - i

Figura n°24 - Média

Seleccionar a varidvel Nota Trabalho da lista das varidveis fonte (do lado

direito, utilizando a seta que se encontra no meio do ecra. Depois, premir o ; _-
botdo Statistics e seleccionar Mean. De seguida optar por Continue &
finalmente, clicar ok. :
O resultado da média aparece automaticamente na janela de Output

Viewer.
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% Frequencies

Statistics
Nota Trabalho
N Valid 5
Missi_ng 1]
Mean 980

Figura n925 - OQutput Média

A Média das notas dos trabalhos é de 9,80 valores, nos cinco alunos do
exemplo.

Nota 1: No caso de ndo se ter fechado a janela de Output Viewer no
exercicio anterior, o resultado relativo ao calculo da média apareceu na
mesma janela de Output.

Nota 2: Para guardar as janelas de Output Viewer, ir ao Menu File > Save,
indicar o nome do ficheiro e o local onde devera ser guardado. Este ficheiro
€ guardado com a extensdo. spo. Ha vantagens em guardar os resultados
em ficheiros separados. Permite mostrar sé um resultado ou imprimir sé um
resultado, enquanto um sé ficheiro-pode tornar-se muito extenso, com

muitas folhas para impresséao.

Para se obter a Moda

Para calcular a moda das idades dos alunos de uma turma (ver exemplo
anterior), realizam-se os passos seguintes:

Optar novamente por Analyze - Descriptive Statistics & Frequencies.
Alterar a designagdo da varidvel Nota Trabalho e seleccionar Idade.
Seleccionar a varidvel Idade e premir o boto Statistics, seleccionar Mode.
Nesta janela fica entdo activada a opgdo “mean” na sequéncia do exercicio
anterior. Para optar por “"mode” desactivar “mean”. Contudo, ao seleccionar
ambas as estatisticas obter-se-30 os dois resultados em Output. Premir o

bot3o Continue e OK.
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= Outputh - SPSS Viewer

= Frequencies

A Moda deste exemplo é 21,
mas também é 22 porque

Statistics
existem dois casos com 21
anos e dois casos com 22
Statistics anos.
Idade 3
N Valid 5
Missing 0
Mode 212

a. Multiple modes exist The smallest value is shown

ldade
Cumulative
Frequency | Percent | Valid Percent Percent
Valid 21 2 40,0 40,0 40,0
22 2 40,0 40,0 80,0
23 1 20,0 20,0 100,0
Total 5 100,0 100,0

Figura n°26 - Moda

Transformacgdo de Dados

O SPSS permite criar novas varidveis a partir das existentes, ou alterar

valores de varidveis j& existentes, usar fungdes e condigdes logicas.

Calculo de uma variavel

Para calcular, por exemplo, a nota final dos alunos de uma disciplina, como
base na nota do trabalho e na nota do teste, criar-se-4 uma variavel a
partir de um calculo de varidveis existentes. Assim, para criar a nova

variavel Nota Final, proceder-se-a como indica a figura seguinte.

=1 Untitled - SPSS Data Editor
File Edit View Data Transform Analyze Graphs Utlities Window Help

EIE_IQI_J_J:IEIEJ_I PR ebd ] T -

Nome | Idade { Sexo | Nota Trabalho| Nota Teste|  var |
0do 22 |Masculine | L
Tania | _21Feminino | *5 ja1f BN

|
|
|
.S e = L i —

Sl jlalina]—

Figura n°27 - Exemplo
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Para adicionar a varidvel Nota Final e fazer os calculos de forma automatica,

ir a0 menu Transform, escolher Compute.

Variavel = | T — — p— = - —
destino T " [Mota_Trabako + Nota_Texte) /2 < - Expressdo
T ! ; 5

o b & |
L § 1) Sexo 2 1 {-l :vf 415]6 {rmengs] = -
B B #®NoaTebshoNotal | 2 =l i ]'.'3 Awﬂw‘vmmw-l =
3 | ==t [ARSINfrumenpr)
Varidveis #A&”‘“"Tm“‘“’-’“ | __ﬂ i ARTANInumesp)
E] . i COFHORMizvalue] E
- m— .,.;:.;,m;,m COF SERNOULLIias) L
T P T
_.....z_gi. [[OK] Poste | Resot| Concel| heb |
g T T ;

Figura n°28 - Compute

No campo Target Variable inserir o nome da varidvel nova (ex: NotaFinal,
ndo esquecendo que esta variavel n3o pode conter espagos), no campo
Numeric Expression colocar a expressdo de como resulta o valor da nova
variavel (ex: (Nota Trabalho + Nota Teste) a dividir por 2), premir OK.

s Untitled - ¥
mmmmxmmemmmw

= EIEJ;:J_.@J_IEE[ SEE T - ._H

A NoteFinal e ies
. | Nome| idade | Sexo |Nota Trabalho| Nota Tesie NotaFinal | var
1|Jodo 22 Mascu_l_i__r_:_u_ - __13__ - 12 1250
2|Tania 21 |Feminino | 15 14 1450

e | = e

Figura n°29 - Resultado Compute

Supondo que a nota do trabalho correspondesse a percentagem de 20 % da
nota final e, a nota do teste a 80% da nota final, a expressdo a adoptar
seria a seguinte: (nota_trabalho*0.20) + (nota_teste*0.80).
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Modificacao de valores

Modificacdo do valor de uma variavel

Partindo do exemplo anterior, para aumentar de 13 para 14 a nota do
trabalho do aluno Jodo (do exemplo anterior).

Posicionar o cursor no caso “Jodo” e depois ir ao menu Transform 2 Recode
> Into Same Variable, seleccionar a variavel “nota do trabalho”. Premir o
botdo Old and New Values para indicar a alteragdo pretendida. Inserir o
valor 13 no campo Old Value, e 14 no campo New Value do lado direito da
janela. Clicar em Add e primir o botdo de Continue e primir OK na janela

anterior.

Fie. Edit  View Dasta  Transhorm  Anshyse Gaphe Uhlibes  Window *-ws

slaal= ﬂluiklﬁj_J__l@mr_l

__N r__ﬁf:!::::’m:;:::::_—_ﬁ':.‘_”ﬁf‘r‘—' _ -
Nome

1jJodo
2|Tania
3 | ——————————
4
&
8
? ..... —
8
. i Systemmissing
0 " System- of user-missing o -
-l C Range. |
12 = = e 3 g ;
- e
T Lpmreat TG
17 | ; . ety bighest 1 o
18 i " All other values . ml w ] H‘h I : ___E___
13 : b - - ;
20 =

Figura n°30 - Modificagdo valor variavel

Como se pode verificar na imagem seguinte o valor foi alterado

automaticamente.

= Disciplina.sav - SPSS Data Editor
Fie Edt View Data Transform Analyze Graphs Utiities Window Help

Slais| ][] tle] W 1F] Bl el
Idade } Sexo Teste | NotaFinal | var | v
f 1fJodo . 22 Masculing | uiy 12 1250/ | =
' 2|Tania 21 Feminino 15 14 1450 '
: 4 —— - \! -i———..—_....‘.1!____.__

Figura n°31 - Resultado modificagdo valor varidvel
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Modificacdo do valor de uma variavel para uma nova variavel

Sempre partindo do mesmo exemplo pretende-se criar uma variavel nova
para categorizar os alunos com nota positiva (>=10) e os com nota
negativa (<10). Para criar esta nova varidvel designada por “classificacao”,
ir ao menu Transform, Recode, Into Different Variables.... Seleccionar a
variavel “nota final”. Seleccionar esta varidavel e coloca-la no campo
Numeric Value com a ajuda da seta. No campo Output Variable inserir o

nome da varidvel nova - classificacao -e premir o botdo Change.

Figura n°32 - Modificacdo valor varidvel para uma nova variavel

Posteriormente, premir o botdo O/d and New Values para especificar a

codificacao.

E: ‘
7 arinbisg oo
_3. o s
4 __ 2 abile
11
-
13
R e e T e
18]
=8
¥
18
18
SRS
i__._g‘:. = i heough highest
| 1; | £ Alothe: vakes
e - | et

Figura n®33 - Modificagdo valor variavel para uma nova variavel
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A nivel da categorizacdo os valores negativos irdo corresponder ao numero

1 e os positivos ao numero 2.

Para categorizar os valores negativos:
Seleccionar a opcao Range: Lowest through e insirir o n°10 para os
valores inferiores a 10, e do lado direito da janela insirir no campo
New Value o valor 1. Premir o botdo Add.

Para categorizar os valores positivos:
Seleccionar a opgdo Range: through highest e inserir o n°10 para os
valores superiores a 10, e do lado direito da janela insirir no campo

New Value o valor 2. Premir o botdo Add.

Premir o botao Continue, e OK da janela seguinte.

=] Disciplina.sav - SPSS Data Editor
File Edt View Data Transform Analyze Graphs Utiities Window Help

slEla/=) - =lo| W fe SR

7 NotaFinal

“Nome | o Sexo Nota_Trabalho| Nota Teetei NotaFinal mm"\%r
1]Jodo 22 ‘Masculino 14 _
2|Ténia I 21 Feminino | 15__ g,_ng__ -
3{Manuel T 21 Mascdline | 1_2_5_ e 2 1ﬁCIT ______
- e e s —— L =
5|Joana 23 Feminino | 0 1_,E_If
6 I TR T e :
-

Figura n°34 - Resultado nova variavel a partir de outra

Para indicar as correspondéncias dos valores 1 e 2 ir a janela Variable View,

posucmnar—se na variavel c!ass:frcacao e definir Values.

e ‘.I“"K ilam Editer

v Duts Tramdom Aidhes Graphs Lilkes Windee el

S8 | elb] 4l AiE DEF ol

Mame i Type T\Mdlh—l Decimals I Label

Mome {String B 3 9 |Left Nummsl
jdade  |Numenc 11 _ 8 ~ [Right___ Nominal _
Sexo String 19 9 |

_Nota Trabao_None
_[NotaTeste hons

£
e T

NuiaFmai =
cl-ssrﬁcaca?&:menc =

§ Value Labels

pe - —— _- AT ST
- R s ; c:: : e

7 [ SN N i i o == | . S v -

Figura n°35 - Alterar Value Label
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Apos ter definido as Value Labels, posicionar-se na janela Data View e

verificar os valores da coluna “classificacao”.

=] Disciplina.sav - SPSS Data [ditor

mmmmammemm"'

Sla18/ ] <[ b W 7

 Nome | T | Sexo |Nota Trabaiht;l Nota Teste | NotaFinal f

1]Jodo | 22 |Masculino | 14 12]
e ool stk ! B
3|Manuel 12 B 950]
e 2 N BL e s LG
5lJosna | S l:lI il}j 5

o L 4

Figura n®36 - Resultado alteragdo value label

Exploracdo e Cruzamento de Variaveis

Histograma

Histograma € um gréfico construido com rectangulos da mesma base. S&o
colocados uns ao lado dos outros e tém altura proporcional a quantidade a
representar. Supondo que se pretende mostrar um gréfico sobre o tipo de
Leitura dos Hiperdocumentos mais utilizada numa formacdo a distancia
(exemplo). Seleccionar no Menu Analyze > Descriptive Statistics > Explore.
Seleccionar a varidvel Leitura do Hiperdocumento para a Lista das Variaveis
Dependentes (Dependent Llst)

s Insuficient

: k

Bol
| Suficient
Buficient

| Suficient

o Boy

Bom

Figura n®37 - Variaveis para construgdo Histograma

Premir o botdo Plots e seleccionar Histogram. Optar por continue e depois

OK.
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Figura n°38 - Histograma

Na parte inferior horizontal do gréfico (eixo do xx), aparecem os tipos de
Leitura do Hiperdocumento:

1 - Lé no ecra

2 = Imprime

3 - Misto (Lé no ecrd e Imprime)

4 - Qutro
Os valores situados na parte lateral do gréfico (eixo dos yy) representam o
numero de pessoas que seleccionaram a opc¢do. Para abrir a janela Chart
Editor dar dois clicks no histograma ou clicar com o botdo direito do rato e
seleccionar SPSS Chart Object > Open. Esta janela permite editar e

modificar os gréficos, alterar as cores, o tipo de letra.

PR

£
:,
&

“
I

T T T T Dev.« 0320
1 Hetd

2 3 4
Leitura do Hiperdocumento_Cumprimante do
Objectivo

Figura n°39 - Chart Editor

Cruzamento de variaveis

O cruzamento de variaveis tem como finalidade de cruzar informacdo, por

exemplo, relacionar o tipo de Leitura do Hiperdocumento com a Estratégia

de Navegagdo. Optar no menu por Analyze > Descriptive Statistics =_
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Crosstabs. Seleccionar a variavel Leitura do Hiperdocumento para as linhas
e a variavel Estratégia de Navegacdo para as Colunas (consoante pretenda

visualizar). Premir OK.

Pl Eilr - Vider s ranchoi - Ansvis

formato misto _P_o iac
rarmaw mlsm i rarque c
Ié o ecrﬂ 'E mais @

At I e Loz o
=8 = _}_! [Ty LRl
c Leftura_Hiperdocumentd Leitura_ an Esirategia_Navegag!
ar_f .

YIS
| 2
=
; i
.............. iTomwse | F‘BSW“ A | 8
formata misto € Pmmsa 9 | I
formata musto 9 Explmgéu af | b i | =
mprime. IMais dp | Exploragdo A} {® Contedrdo Interackinl |~ oo | 5
k= lar_rg'_raio misto Jmpnma iy ____Daamhu!a;lo C] T Disghay chistesed bay charts e
imprime 8 A " =
=

Figura n°40 - Cruzamento variaveis

Na janela de Output Viewer visualizar a seguinte tabela:

Leitura do Hiperdocumento_Cumprimento do Objectivo * Estrategia de Navegagio_Descrigio_Cumprimento do

objectivo Crosstabulation
Count
Estrategia de Navegagdo_Descrigdo_Cumprimenta do
ohjectivo
L4 Pesqguisa | Procura Exploragdo | Deambulagdo Total

Leitura do 1B oecrd 3 0 0 0 3
Hiperdacumento_ imprime 2 i) 2 1] 4
ggﬁme“‘“ do formato misto 3 1 1 1 6

4 1 0 i} 0 1
Total 9 1 3 1 14

Figura n°41 - Output cruzamento variaveis

Nas linhas obtém-se informag&o sobre a Leitura do Hiperdocumento e nas

colunas sobre as Estratégias de Navegagao.

Para fazer o cruzamento da mesma informacdo, com a apresentagao da
percentagem por coluna, optar no menu por Analyze -> Descriptive
Statistics > Crosstabs. Seleccionar a variavel Leitura do Hiperdocumento
para as linhas e a varidvel Estratégia de Navegagdo para as Colunas. Premir

o bot&o Cell, seleccionar Column nas Percentages, premir continue e OK.
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Crosstabs: Cell Di

Figura n°42 - Percentagens

Obtém-se a seguinte tabela:

Leituga do mmmm_cmmﬂ do Objectivo * Estrategia de m&e_msm;in_ﬁu.....' nto do objective Crosstabulation
Estrategia de Nmgagéo_mscﬂgéo_cumprimenm do
iy U
Pesquisa Procura Exploragdo Deambulagdo Total
Leitura do Eoecra Count 3 [i} [1] 0 3
!éﬁpardocummr_ % within Estrategla de
umprimento do Navegacdo_Descrigdo_
Qs Cumprimerio do Y 333% 0% 0% 0% | 214%
ohjectivo
imprime Count 2 o 3 0 4
% within Estrategia de
Navegagdo_Descrigao_
Cumprimento do 222% 0% 86,7% 0% 28,8%
objectivo
" formato misto  Count 3 1 1 1 E
% within Estrategia de
i
s i 333% | 1000% | 333% 1000% | 429%
objectivo
4 Count 1 a ] 0 1
% within Estrategia de
Smﬁﬁﬁﬁaﬁ Zi‘"‘“- A% 0% 0% 0% 71%
objectivo
Total Count 9 1 3 1 14
% within Estrategia de
Navegagao_Descriglo_
Cumprimento do 100,0% 100,0% 100,0% 100,0% | 1000%
objectivo

Figura n°43 - Output Percentagens

Nota: Ter em atencdo que, neste exemplo, a percentagem corresponde a

variavel Estratégia de Navegagéo.
Para visualizar também a percentagem das linhas (neste caso da leitura do

hiperdocumento) no ecrd onde se seleccionou a percentagem por colunas

seleccionar também as linhas.
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Modificar o Output

Pivot Table Editor

Permite editar e modificar tabelas. Editar textos, trocar os dados de linhas
com colunas, adicionar cor, criar tabelas multidimensionais, etc.

Para utilizar no PTE no output viewer optar por uma das tabelas onde se
quer alterar os titulos ou os dados. Nessa tabela dar dois clicks para a
editar ou clicar com o lado direito do rato (neste caso seleccionar a opgao

de SPSS Pivot Table ObjectEdit)

s ek esse_d 0 3t e

e 1 za
Bem 8 w0y

Camzam

Frequanir | Pwuent | vemg Pavers | Pacuse
1 i) T

M

o

Figura n®44 - Pivot

Para alterar a ordem das linhas com as colunas ir ao menu pivot e

seleccionar Pivot - pivoting trays.

{ | Contetdo_in
teresse_Co Contatd C ¥

mpreensdo_ Graude Clarezs_ | Compraens:
da_actividad o by oy

do

Frequency Table
= 2l _Comp _da_;
: Cumutative
Fraguen: Parcent | Valld Percent Parcert

Vals  Sutients B 429 4238 (5]
Bom 7 50,0 50,0 829
Muito Bom 1 14 71 100.0

Total 14 100,0 10,0
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Para alterar a coluna para a linha arrastar o icon da coluna (canto superior
direito) para a linha (canto inferior esquerdo). Para passar a linha para a
coluna proceder de forma inversa.

Text Output Editor

Permite alterar o tipo, tamanho, cor e estilo de letra do texto.

No TOE seleccionar o output viewer, optar por uma das tabelas onde se
quer alterar os titulos, cor de letras, tamanho... ou dados. Nessa tabela dar
dois clicks para editar a tabela ou clicar com o lado direito do rato (neste
caso seleccionar a opgao de SPSS Pivot Table Object Edit.

Selecionar primeiro o texto que quer alterar e utilizar a barra de
ferramentas que aparece na interface

Figura n°46 - Editor Texto

alizacdo Grafica

co — Simples
construir um gréfico simples que represente as diferentes estratégias

Navegacdo. Regressar ao exemplo e posicionar-se na janela data view.

menu Graphs > Bar. Escolher Simple e premir Define.

eerafo misto [Pore ¢ |
Woecrd Emaise | v cp

Figura n°47 - Definicdo Grafico Simples
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Visualizar o ecr@ seguinte e depois seleccionar a varidvel para Category
Xis e premir OK.

BB Define Nm:pl‘ Bar: Summaries for Groups of Cases

se—e BN
{® Conteido_interesse | Cumnofcases Zolcases | _Pa
| Clareza do Contedd | ver summary hunction e H‘“‘I
-@erdatwnmﬁii ,ﬂ,_,;v. _ ; i

@ Conteido_Clareza_ Ef L pEE _c";._"’"J
@ Conteudo_Compree e s

@® Conteddo_Compree '
@ Contetido_Compree
@ Conteuido_Flexibilid.
#® Contedido_Flexibilid.
@ Contetdo_Flexibiid.
#® Contedido_Interacti
@ Contetido_Interacth

Figura n°48 - Definicdo varidveis para Gréfico Simples
Obtém-se o seguinte gréfico:

= Graph

B

Count

4

o

Pesquisa Procua Expi e
Estrategia de Nanpgh_pnerl;io Cumprhom do
objectiv

Figura n°49 - Grafico Simples
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Graficos - Cruzamento de trés varidveis
Mas para visualizar um grafico que represente a estratégia de Navegacéo de
acordo com o conteudo e agrupado pela Leitura do Hiperdocumento, ir ao
menu Graphs - Bar. Escolher Clustered e premir Define. Seleccionar a
variavel “Estilo de Aprendizagem” do lado esquerdo do ecrd, escolher a
opgdo Other Summary function e colocar aqui a varidvel seleccionada.
Depois seleccionar a variavel “conteiido”e colocar em Category Axis e a
variavel “Leitura do Hiperdocumento” em Define Clusters by. Premir OK.
B Define Clustered Bar: Summaries for Groups of Cases
_ ~Bars Represent-
© Nof cases " %Zof cases

" Cum nof cazes medm%

|
@ Other summary funclion . Resst |
Hep |

(2] [® Meantestio e Avend

f& Contetido_Flexibilid- m l {@ Eﬁ(dm de Navege

@ Conteido_Flexbiid . Define Clusters by:

{® Leitura do Hiperdocu

4 Contetido_Interacti st 1
“ Conteddo_Interacti ‘i“' Uumm&mm : ;

Figura n°50 - Definigdo Grafico com trés varidveis

Obtém-se o seguinte grafico:

The & g
G || 0%
& B Crossabe 'o

Mean Estilo de Apr

Figura n°51 - Gréfico com trés varidveis
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Modificagdo do grafico

Para se fazer alteragbes no grafico:
» Dar dois cliques sobre as barras do grafico. Surge a janela Properties.

e Seleccionar o separador Variables. Arrastar a variavel para o eixo que
se pretende.

e Premir Apply e depois Close. Fechar o editor de graficos.
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Figura n°52 - Modificagdo grafico

Impressao e Relatoérios

O SPSS permite a impressao de:
* Tabelas, Graficos e Texto da janela de Output.
e Ficheiros de dados do Editor de Dados.
e Comandos de janelas de sintaxe.

66




Imprimir a janela de Output 1 e

Antes de imprimir os resultados ir ao menu File e premir Print _ :

2 Dutput1 - SPSS Viewer (all visible output)

Definir as propriedades
da pagina de impressao

Visualizar
pagina
seguinte

Frequency Table
e iae do Conude_Cum priment do Coctie

bt |
Faguescy Permat | Valti pemzat Perwst
P T 5 FE] 3] =7
Visualizar em o 5 v b
duas paginas . e —

Conwine_Jare o _Compresns Bo_Sohd dads

o]
Pepeat | Gamidemest | Peseat

'ﬂ ey
T R | ] K] il K]
etk ] *7 =3 e
20 ET] ®3
o o 1 2] 14 o
it M0 o
Graph

Figura n°53 - Imprimir janela Output

Para definir as propriedades da pagina que vai ser impressa premir o botdo
Page Setup, esta opgdo pode também ser visualizada a partir do Menu File
da pagina de Output, premindo Page Setup.

Figura n°54 - Opcdes de impressao
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No ecrd de configuracdo da pagina indicar o tamanho do papel e a or¥
Definir a posicdo da pdagina (vertical ou horizontal, e o tamanho'
margens, superior e inferior, da esquerda e da direita). Premir 0 B

Options, para definir o texto que aparece em cabecalho e rodapé.

Page Setup: Options

,T‘_ﬁF",’S?_.'-{,a[r_‘.p SEe e

_isﬁ_m_!glal o DEE®

~Fooler e .

Hiiatn Pae Magnisnes semeni s

[ oK | Coslsr |  Awds | MokeDotaut |

Figura n°55 - Configuragdo pagina

Os itens da janela de Qutput podem ser impressos de duas formas, optando

por todos os itens visiveis na janela actua ou apenas pelos itens

seleccionados.

Privit Prevme Vahd " 14
Mizsing 0 ]
Racently Lised Data >
R Flos »
setyssdfles "’ IFrequency Table
Bt
Ieresse do Comteddo_Cumprimento do Ohjective
Cumulative
Fre Percent | ValidPercent | Percent |
= [Vahd Suficiente 5 3BT - ) 357
Bom 7 50,0 50,0 657
Muito Bom 3 14,3 143 10,0
Total 14 108,0 1000

Figura n°56 - Impressdo janela output
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Para imprimir o Output ir ao Menu File e premir Print. eq
tipo de impressdo que pretendida (imprimir todo o output v

pagina ou imprimir s6 o que estiver seleccionado). Depois clicar em OK.

imprimir

Seleccionar a Estado: Preparada

impressora Tipo: wpscﬁww ;
Localizaco: USB003 =
Comentario: : r Iwhipmﬁdwioj
Imprimir o ~ Intervalo de impressdo ~ Copias

Numero de

‘NGmero de cépias: |1 —=j&— copias

output todo ~ii
~ Al visible output

{* Selection  Imprimir o output
- seleccionado

 RIRAB A L PRI Laie

@]@@' Agips

Premir OK para : : _ I St
Imprimir i : l

Figura n°57 - Seleccionar Impressora

Controlar a impresséo de tabelas muito grandes
Para controlar a impressdo de tabelas de grande dimensdo pode-se
introduzir algumas quebras que irS0 facilitar a leitura do documento

impresso.

Fazer uma quebra de coluna ou linha para imprimir um documento
Para fazer uma quebra numa coluna de uma tabela editar a tabela, dando
dois cliques na tabela ou clicar com 0 botdo direito do rato na tabela e
premir Pivot Table Object, Edit.
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Figura n°58 - Editar Tabela

Apés editar a tabela pode posicionar-se na coluna onde pretende fazer a
quebra. Pode seleccionar a coluna toda, fazendo Ctrl + Alt + Clicar no topo

da coluna, depois vai a barra de menus escolhe Format e clicar em Break

Here.

o

Tabde Prepartiet,
Tabledooks. ..

= & Frequences

Figura n®59 - Quebra coluna

Para fazer uma quebra de

seleccionando a linha onde pretende fazer a quebra. Para remover a quebra
de coluna ou linha, pode seleccionar o sitio onde pretende remover e

seleccionar a linha ou coluna, depois vai ao menu Format e prime Remove

Break Here.

Bom

Slfciente
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Este simbolo
indica que a
coluna tem

uma quebra

Figura n°60 - Remover quebra

Imprimir a janela de dados

Para imprimir os dados a partir da janela Data View seleccionar no menu
File, Print. Imprimir os dados todos, os dados seleccionados ou os dados de
determinadas paginas.

Relatérios em Word

Os resultados estatisticos criados no SPSS podem ser copiados para o
Word, onde normalmente sdo criados os relatoérios.

Para copiar uma tabela clicar com o botdo direito do rato e seleccionar
Copy, depois pode entrar no Word, posicionar-se no local onde se pretende
inserir a tabela e fazer Edit, Paste.
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i l'!r.i!{_lul? SPSS vV

EELE!!i&!JE!_JE_I_I_!!_J_H

do o'B]'Eﬁv‘u demonsirado do Objecivo
N vaid 14 14 14
Missing ﬂ 0 1] i)
Frequency Table
Interesse do Conteddo_Cumprimento do Objective
Cumuiative
Frequency | Percent | Valid Percent Percent
Valid Suficiente 5 35,7 35,7 35,7
Bom aNn an0 857
Muito Bom WhatsThe? _t 1008
Total 1t cut
—| Copiar tabela =
como objecto [y Copry objects
Paste After
—enBlOSS _ —Pm
Create/Edit Autoscript
L( Cumulative
Fraql._le_nf Percent
Valid  Insuficiente msults Coach 1 74
Suficiente . SRS ¥ 28,6
Bom SPSS Pivot Table Obpct v 13 923
Muito Bom T T A 100,0
Total 14 100,0 100,0

Figura n°61 - Copiar tabela

As tabelas podem ser copiadas como imagens ou como tabelas edita
no Word. As imagens ndao podem ser editadas no Word, s6 podem
redimensionadas, enquanto se forem copiadas como tabelas, o
contelldo ja podera ser alterado no Word. Os graficos s6 podem
copiados como imagens para o Word. Qualquer alteragdo de um gréfico,

deve no SPSS copiar novamente e colar no Word.
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